Internet Concepts
1

ISP – This term Internet Service Provider is used to refer to the company which is
providing our Internet connection. Therefore, for all your internet needs, first you
need to connect to the ISP and then through the ISP you will be able to connect to
the whole world.

2

FTP – This File Transfer Protocol is another service provided on the Internet. Using
this service, servers will be able to provide their files to client computers in a
format which is more suitable for files.

3

Torrent – A Peer to Per sharing system where data comes not from 1 centralized
distributor but from many other clients, people downloading the file. Each client
shares/sends pieces of data with others reducing the cost and load on any given
individual source. People who want to download the file are called 'Peers' and the
'tracker' is a single computer maintaining the list of clients from where to
download. The group of peers are called a 'swarm'.

4

Logon Websites – Since the Internet is open to all, some websites include some
sections which are restricted to a group of users. This restriction is made by
enabling the user to Logon into the website using a Username and a Password. The
process to get a website Username & Password is called Registration. Some
Registrations are free of charge while others are against payment.

5

Spam – The term SPAM refers to unsolicited e-mails. Giving your e-mail address to
many websites may result in your e-mail being abused and your Inbox being
bombarded with hundreds of unwanted advertisement e-mails.

6

Fraud – Never give your details or worse still credit card details to anyone or any
company unless you know that you are dealing with a reputable organization. You
may find that the items you purchase are never delivered, or worse that your
credit card details were used fraudulently to make other purchases.

7

Submitting Forms – Some websites provide a space for writing. After filling in the
required in the necessary information, we send the information using a button on
the web page. This sending of information to a website is usually called
Submitting.

8

Bookmarks/Favourites – Whenever we need to take note of a website address, we
bookmark it in our browser's Bookmarks/Favourites. The advantage is that if in the
future we need to revisit the website, we use its address in our organised
Bookmarks folder. Bookmarks can be added thorough the main menu while
viewing the web page. Bookmarks can also be organised into Folders. Remember
that bookmarks save only the address. Some browsers include also Dialups to save
the website on the background starting page of the browser.

9

Search Engines – A Search Engine is a special website which enables us to find
other website addresses. A Search engine works in this way:
•

First, the Search Engine browses millions of websites by itself.

•

While browsing, it keeps relevant information about the visited websites.

•

When we use the search tool of a Search Engine, the Search Engine
database displays a special webpage with the websites which may be
related to our search.

•

On clicking the links, we will then be able to check out these websites
without typing or remembering any website address.

•

In our Search, we should only include the keywords of the required stuf
and if we need to further fine tune our search we use the engine's
Advanced Search tools.

•

The best search engine on the web is currently: www.google.com.

10 Printing – All browsers support the basic printing of a webpage. Still, the printing of
webpages directly from browsers tend to waste a lot of paper and ink to print
unwanted material – such as advertisements, menus, borders, backgrounds etc.
Therefore it is more advisable to Copy->Paste Special the required material from
the webpage into a word processor and then print it from there.
Online - Shopping
1. Steps – Steps required to buy something online:
•

Browsing to the website from where you need to buy something.

•

Search for the required product in the website's search engine.

•

Since most websites use the Basket/Trolley shopping system, select
the products you need, by clicking on the 'Add to Basket' icon.

•

When finished Adding items, click on your Shopping Basket to check
the items you have got in it. Change the quantities or delete the items
if necessary.

•

Then “Proceed to Checkout” and most websites will require that the
user Registers with the website or Logs In/Signs In with his Username
& Password if he has already used the website.

•

Then you will be prompted with information and options which enable
you to insert the Dispatching Address (where to send the physical
goods).

•

Finally and most importantly you insert the Credit Card details – from
where the on-line shop is going to get the money. Try to use PayPal for
a secure transaction.

•

Finally, press Finish, Purchase or Pay ONCE and the shopping is done.

2. Security – Since on the Internet there exist thousands of fake, cheating virtual
online-shops, the following are some tips to verify whether the website is a genuine
one or a fake:
•

When inserting Credit Card details, a genuine online-shop will provide an
Encrypted webpage (your browser will show a closed padlock on the
screen);

•

The Digital certificate should be verified by a trustable Authority (your
browser will warn you about it if it is expired or the Authority is not a wellknown one);

•

The website includes a real physical contact address (on Earth not on the
Internet) and the Contacts include real working telephone numbers and
not only E-mails;

•

The website is a popular one – your friends have bought things from it
and so it can be trusted.

If any of these is missing, better not use its services and find another more secure
shop. If you suspect that your Credit Card details were used illegally, immediately
inform your bank to stop all card transactions and order new Credit Card.
3. Phishing - The term comes from "Password Fishing". Phishing is a type of deception
designed to steal your valuable personal data, such as credit card numbers,
passwords, account data etc. The criminal tricks their victim into believing they are
communicating with a trusted source. Ex: users receive emails that attempt to fool
them into disclosing online banking passwords, by sending them to a site that looks
very similar to of the bank's Web site.
4. Website cookies – To enable simple user identification, some websites use Cookies.
A cookie is a very short code (numbers & letters) which is sent over by the website to
uniquely represent your computer. Afterwards, whenever the browser contacts that
website, the browser sends this cookie and in this way the website will identify the
user. This is usually used for automatic personal greetings.
5. Internet Cache – Whenever the browser accesses a webpage, the browser
downloads the text, images and any other objects related to that webpage. Since
downloading takes time, browsers uses a system of cache which means that a
selection of the automatically downloaded stuf is saved temporarily on disk. If the
user then goes back to that website, the stuf is loaded from the disk instead of
downloading it again.
6. Digital certificates – Everybody connected to the Internet can create his own
website or web server. In this way anybody can say that his is someone else, since
there is NO WAY to prove that a website is a genuine one or a fake. To minimize this
problem, Digital certificates were invented. From a well known authority, such as
Microsoft or Verisign, genuine websites will obtain a digital certificate signed by these
trusted authorities. Clients using these websites will be able to verify their certificates,
thus making sure that the website is not a fake. (since we trust Microsoft that it
checked out that the website is genuine).
7. Encryption – When we need to send important confidential data (Credit Card
numbers) over the Internet, we must make sure that our data is not snifed
(intercepted, copied, edited) by illegal users/programs. Therefore a system to Encrypt
(scramble) the data sent over the Internet was invented. Nowadays we normally use
at least a 128-bit encryption. In this way we are sure that even if someone intercepts
the data, he/she will not be able to make any sense out of it. Ex: hello encrypts to
'ifmmp'

8. Firewalls – While connected to the Internet, more important than Anti-viruses are
Firewall programs. Firewalls enable the user to control all the communication between
your computer and the Internet. In this way we can identify programs/viruses which
are trying to connect to the Internet without our permission and also block illegal users
which are trying to connect to your computer without permission. Nowadays, most
anti-virus programs include a firewall. Still stand-alone firewalls exist:
www.zonealarm.com
9. View History – To view a list of the websites we visited, we use the History icon in
the Standard toolbar. This is useful to retrace a website you visited but forgot its
address.
10. Delete Cache – To delete the temporary Internet files saved on your hard disk
which were used to help cut on downloading time, use the Tools->Internet Options>General tab.
E-Mail – Electronic Mail has many big advantages, and these include: High Speed
delivery (almost instantaneously), Low cost or Free of charge, Worldwide Portability can be accessed from anywhere around the globe. Still it has one single disadvantage
– Only digital/computer information can be sent, physical objects cannot be sent!
An E-Mail address – An E-Mail address consists of 3 essential parts. The username of
the receiver, the @ symbol and the name of the server to which the receiver is
subscribed for the E-Mail service. Ex: joan@hotmail.com Joan is the username and
Hotmail.com is the server providing the E-mail service. Spaces and special characters
are not allowed in E-mail addresses and all characters are kept small letters (no
Capitals).
E-mail Netiquette – Although E-mail is practically used everywhere and is very useful,
abuse is ruining the E-mail service. Nowadays it is very common to open the E-mail
box and find unsolicited, unwanted, junk e-mails. Apart from preventing the disclosure
of your E-mail address and other people's addresses one should follow these few steps
when writing an E-Mail.
•

First, the Subject should be clear enough to give an idea about the
contents of your E-mail

•

The message should be short & sweet (brief & to the point -since most
people don't like to read lots of text)

•

Do not Forward fake advertisements or useless chain letters!

E-mail Box Size – Since E-mails take physical space on the Hard Disk of the server, Email boxes are given a limit on their size. If that limit is reached, the server providing
the E-mail service will send back (the sender will be notified that the delivery was
unsuccessful) all your received e-mails until you Delete messages make some space in
your Mailbox.
Compatibility – Using simple text-only formatting in an E-mail guarantees that all users
will be able to read your e-mail. Therefore, the simpler and shorter an E-mail is, the
better.
Viruses – Using E-mails, viruses can travel from one computer to another and infect all

of them. When you receive an unexpected E-mail, from an unknown user with an
attachment, make sure that you delete the E-mail without downloading the
attachments.
Security – The common E-Mail service provides no level of security. The messages are
sent as plain text and anyone on the Internet sniffing the communication can easily
read your E-mails. Therefore, plain E-mails should never contain confidential
information such as passwords, bank accounts or worse still credit card numbers. To
make e-mails safer we can use Encryption tools, encrypted attachments and to
digitally sign an e-mail (to verify the sender) we can also use personal Digital
Certificates.

Using E-Mail
Registering for an E-mail address – Before we can start sending and receiving E-mails
we first need to apply/register for an E-mail address. Many websites provide free Webmail services while ISPs usually provide real POP3 E-Mail. The POP3 email is the
original and fastest type of E-Mail is usually against payment, provide more storage
space & large size e-mail handling, better SPAM and anti-virus scanning tools and
above all provide a faster service.
IMAP - Internet Message Access Protocol. It is a system used to check & send e-mail,
where emails reside on the server instead of the client application. Messages are read,
stored, and organized on a remote server, rather than downloading them all to a single
client computer, as is usually done with POP3.
Programs – POP3 & IMAP E-mail programs exist, such has Opera Mail, Evolution,
Thunderbird and MS Outlook Express. Free WebMail addresses can be registered on
Google Mail, Windows Live and Yahoo.
Logging In – To check out the contents of your E-mail box, we first Log In/Sign In. Using
the Username (the first part of your E-mail address) and the Password, the e-mail
server verifies that you are the real owner of the E-mail box.
The Inbox – This box contains all the messages you have received in your E-Mail.
Messages are viewed/opened by clicking on the Subject of the message. We can
Delete unwanted messages, Move and organise messages into diferent folders and
Compose new messages. Unopened messages are usually displayed in a Light Blue
colour using a Bold font efect, while already opened messages are shown in a Black
color with no special font efect.
Emails - Whenever we open an E-Mail we can:
•

Reply (Compose a new Message to the sender),

•

Reply All (Compose a new message & send it to all the receivers it was
originally sent),

•

Forward (send it as it is to other people, including the attachments)

•

Delete (Delete the message).

•

To open attachments, when using POP3 E-mail simply double-click on
them while in WebMail you first need to download them to your computer
before opening them.

Compose – To write a new message, press New or Compose. An e-mail message should
include:
•

The receiver's exact e-mail address (compulsory),

•

The Subject (a brief title for your E-Mail)

•

The Message Body (the Letter).

•

If we need to send any pictures, documents or files with the E-mail we
need to use the Attach button. After Browsing for the file on our Hard Disk
we press OK and the file is uploaded and attached to the E-mail.

•

We may also Tag the message as Urgent/High Priority. (Still this does not
mean that the E-mail will be delivered / considered diferently from the
Normal priority E-mails.

Addressing Options – When sending emailos to:
•

One person, we fill-in the 'To' text box with the recipient's address.

•

To a large number of people, we insert their E-mail addresses one after
the other (separated by a comma) in the 'CC' text box. The CC (Carbon
Copy) option discloses all the addresses of our recipients.

•

The BCC (Blind Carbon Copy) can be used so that the recipients will only
be able to see their address in the E-mail.

Address Books/Contacts – Most email programs support the use of an E-mail Address
book/Contacts. We can add recipients' e-mail addresses and avoid typing &
remembering the addresses every time we need to send an e-mail.
Sent/Outbox – Saves a copy of the sent e-mails. Sometimes, these mails are deleted
automatically when you log out.
Recycle Bin/Trash – When we delete an E-mail it is usually sent to the Recycle Bin of
the e-mail program. Sometimes, these mails are deleted automatically when you log
out or after a number of days.
E-Mail Folders – By creating folders we my organise the sent and received E-mails in
appropriate folders.
Printing Messages– To Print a message, simply use the menu File->Print. When using
WebMail try to look for the Printer Fiendly webpage which tries to eliminate all the
unwanted menus, backgrounds and colours from the WebMail webpage.
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